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1 Information and Disclaimer 

1.1 EPDECOM V2.0 
EPDECOM is an implementation of the Battelle Two-Curve Method [1] [2]. It calculates the minimum 

required arrest capacity of transmission steel pipes necessary to arrest a running ductile fracture.  

 

EPDECOM references the GERG-2008 equation of state (EOS) computing library from Ruhr Universität 

Bochum, Germany [3]. 

 

V2.0 was developed in 2019 at the University of Wollongong, funded by the Future Fuels CRC, and 

supported through the Australian Government Cooperative Research Centres' Program. The cash and in-

kind support from the APGA RSC is gratefully acknowledged. 

 

EPDECOM is owned and distributed by the Future Fuels CRC. 

 

For more information: 

 
 

Future Fuels CRC www.futurefuelscrc.com 

 
 

Cooperative Research Centres 
www.crca.asn.au 

 

 
 

Australian Pipelines  

and Gas Association 

www.apga.org.au 

 

 
University of Wollongong 

www.uow.edu.au 

 

 

1.2 Warranty and liability 
The Future Fuels CRC strives to deliver a high-quality software product. However, it does not warrant or 

represent (to the extent permitted by law) the merchantability or fitness for a particular purpose of the 

EPDECOM V2.0 software, or that the use of any information disclosed in the EPDECOM V2.0 software 

does not infringe on privately owned property rights. 

 

The Future Fuels CRC will not be liable for any damage that may result from the use of, or errors or 

omissions in, the EPDECOM V2.0 Software, or any information disclosed in or derived from the 

EPDECOM V2.0 software. 

 

1.3 Copyright 
Copyright of the EPDECOM software is owned by the Future Fuels CRC. Unauthorised reproduction or 

redistribution of the program is prohibited.

http://www.futurefuelscrc.com/
http://www.crca.asn.au/
http://www.apga.org.au/
http://www.uow.edu.au/


 
- EPDECOM V2.0 - User manual -  

 

5  

2 Application deployment  

2.1 System requirements 
EPDECOM is a standalone application running on the Microsoft Windows operating system in version 10 

and above. The operating system is required to have 1 GB of RAM memory and at least 200 MB of hard 

disk space available. 

 

2.2 Purchase orders 
 

This section is targeted towards the company’s representative who will place an order for EPDECOM. 

 

EPDECOM V2.0 requires one valid license key per user, per computer.  

 

To obtain license keys for each user within the company, a Purchase Order will need to be placed with a list 

of all users and their corporate email addresses who require a copy of the application within the company. 

Upon approval of the order, each user will be contacted by email and provided with a link to retrieve a copy 
of the application. They will be invited to place a license key request by following the licensing process 

presented in section 2.3.5 ‘License requests’. 

 

For more information on licensing options, or to place an order, please send your request using the contact 

form available at https://www.futurefuelscrc.com/about/contact. 

 

2.3 Installation 
 

This section is targeted towards the users of EPDECOM within the company. 

 

2.3.1 Purchase order 
The company representative must place a purchase order for a list of users. As a user, you must be 

included in this list.  

2.3.2 Download of the installer 
Once the order is approved, you will receive a link by email to download the application’s installer. 

The installer is an executable (.exe) that will deploy EPDECOM on your computer. 

2.3.3 Installation 
Note: Some antiviruses may complain about the safety of the installer.  

Execute the installer by double clicking on it. EPDECOM will be installed in the directory 

“EPDECOM” under your Windows local programs directory. This is typically 

C:\Users\[username]\AppData\Local\Programs\EPDECOM where [username] is your 
Windows user account. This is the installation directory of the application. 

2.3.4 Launch EPDECOM 
Note: Some antiviruses may complain about the safety of the executable. 

The application is best started from the Windows application menu. Alternatively, the executable 

‘epdecom-win.exe’ is available from the ‘bin’ directory under the installation directory. 

EPDECOM must be executed as a normal user. The application will abort if it is started as an 

administrator. 

2.3.5 License requests 
On the first launch, or if the supplied license is invalid or expired, the application will present you 

with its license panel, see Figure 1. 

If you already have a license key, go to section 2.3.6. Otherwise, place a license request as follows: 

 
a. Click the button ‘create a request file’. A window will appear to save the request file at a 

location of your choice. The default directory is the ‘license’ directory of the application 

located under the installation directory.  

 
b. Send the request file to the Future Fuels CRC license manager by replying to the email that 

provided you with the download link to the application’s installer.  

https://www.futurefuelscrc.com/about/contact
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c. Upon receipt of your request file, a license key will be generated and sent back to you by email. 

Save the license key at a location of your choice. It is recommended to save your license file 

in the ‘license’ directory of the application. You can rename the license key if you wish. 

 

 
Figure 1 License panel presented to the user if the license key is invalid or expired 

 

2.3.6 Load the license 
From the license panel (Figure 1), click the button ‘load a license file’ to open a file browser and select 

your license key, see Figure 2. The license panel will set the license status as ‘Valid license’ on 

successful loading. 

 

 
Figure 2 Browse your file system to select your license key file. It is recommended to save your license file in the 'license' directory 

available under the installation directory of the application. 

 

2.3.7 Access the interface 
Click the button ‘Close license panel’ to access the application main interface. The application will 

terminate if the license is expired or invalid. 
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3 User Interface 

3.1 Overview 
Upon start-up (section 2.3.4), EPDECOM will check the status of the license key file (section 2.3.6).  If the 

license key is valid, the user is presented with the main interface as shown in Figure 3.  

 

 
Figure 3 Main interface of EPDECOM V2.0 with the project panel on the left, the units and preferences panel on the right and the 

display panel at the centre presenting the EPDECOM logo.  

The interface is structured around a common menu bar at the top, three control panels and a progress bar at 

the bottom.  

 
The Project panel is located on the left of the interface. It is used to select models, input parameters and 

options, run calculations and select display modes and result cases.  

 
The Units and Preferences panel is located on the right of the interface. It is used to select units and preferences 

for each model. 

 
The Display panel is located in the centre of the interface. It is used to display figures, tables, logs and interface 

options. It displays the EPDECOM logo on start-up. 

 
Entry fields will change colour depending on their status. A ‘sandy yellow’, as shown by the decompression step 

entry field in Figure 3, indicates that this entry is compulsory. A white entry field indicates either an optional 

field or a valid entry. Greyed out entries indicate a disabled field in the current context. 

 

3.2 Menu bar 
The menu bar is accessed from the top left of the interface window. It is composed of three items: File, View 

and Info as shown in Figure 4.  

 
(a) 

 
(b) 

 
(c) 

 
(d) 

Figure 4 (a) The menu bar with the three menus: (b) File menu, (c) View menu and (d) Info menu. 



 
- EPDECOM V2.0 - User manual -  

 

8  

3.2.1 File menu 
The File menu has five items, as shown in Figure 4(b). Item New project clears all entries from the project 

panel and sets the default parameters for the models, if applicable.  
 

Load project opens a file browser inviting the user to select a setup project file, in .eppj format, to load in the 

project panel as shown in Figure 5(a).   
 

Save project opens a similar file browser inviting the user to select a file to overwrite or a location to save the 

file to, see Figure 5(b). The file extension is automatically set to .eppj.  

 

Export results opens a file browser inviting the user to select a file to overwrite or a location to save the file to, 

similar to saving a project setup file as shown in Figure 5(b). The file extension is automatically set to .xlsx.  

 

The directory selected from the Load project, Save project or the Export results items is saved internally by the 

application. Subsequent loading/saving actions will open straight to that directory when the file browser is 

opened. 

 

 
(a) 

 
(b) 

Figure 5 (a) A file browser automatically opens to select a project setup file to load in the project panel. Here the user selected the 
file ‘Demo1_setup.eppj’. (b) A similar file browser is provided to save a project setup file.  Here the user saves a file under the name 

My_new_project.eppj. The file browser is similar when exporting the results in a spreadsheet. 

Selecting the Exit item saves the setup from the Units and Preferences panel (section 3.4) in the user 

configuration file before closing the application. The same action can be completed by clicking the close 

button at the top right corner of the window.  

 

EPDECOM will automatically load the user configuration file on next start-up to set the default preferences 
and units for the user. The configuration file is a .json file located in the config directory of the EPDECOM 

installation directory (section 2.3.3). Although it can be edited with a simple text editor, this feature is not 

officially supported. 

 

3.2.2 View menu 
The View menu has four items as shown in Figure 4(c).  The first item hides or shows the Units and preferences 

panel (section 3.4) from the interface. Once the preferences and units for the study have been selected, this 

panel is not commonly used. Hiding it allows more space for the display panel. Note that this panel is always 

displayed at start-up. 

 
The second item of the View menu shows the options for the Graphical User Interface (GUI) in the display 

panel, as shown in Figure 6. A limited number of options are available, related to the font size or the 

resolution of the interface. The automatic detection of the dpi (dots per square inch) is recommended; 

however, users can uncheck the auto-detection and specify their own. Changes to the font size are 

automatically executed. Changing the dpi requires the application to be restarted.  
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Figure 6 The GUI option panel is accessed from the View menu. It is displayed in the display panel of the interface. 

The license panel (Figure 1) can be accessed from the Show license panel item of the View menu. The license 

panel provides information on the application, its version and branch, the Machine ID the application is 
running on, the status of the license and its expiry date. A button is available to load a license key. The bottom 

section is dedicated to the request license process as detailed in section 2.3.5.  

 
The item Show log panel displays the logs of the current EPDECOM session, see Figure 7. Information 

headers from particular activities are displayed in blue. Non-critical information is displayed in black. 

Successful actions are shown in green. Warnings are displayed in orange. Errors are displayed in red. 

 

The logs are appended to the log file log.txt accessible under the log directory of the application installation 

directory (section 2.3.3). It is safe to clear the content of the log file if it becomes large. 

 

 
Figure 7 The log panel is accessed from the View menu and displayed in the display panel of the interface. 

3.2.3 Info menu 
The Info menu has one item as shown in Figure 4. The About item opens a window providing general 

information on EPDECOM, see Figure 8. 

 

 
Figure 8 The pop-up window 'About EPDECOM' is accessible from the Info menu. 
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3.3 Project panel 
The Project panel is located on the left-hand side of the Graphical User Interface (GUI). It is composed of 

four sections in which the user can provide the input parameters, select models and access data.  

 
Figure 9 shows an overview of the panel. Starting from the top, the Project panel displays the project description 

module, the decompression module, the fracture module and the display module. The decompression and fracture 

modules are within a scroll region. In the figure, the 1D isentropic model is selected; the fracture module is 

not visible but starts shortly after the decompression settings. Information about each module is provided in 

Chapter 5. 

 

 
 

 

 

 

 

 

 

 

 

Figure 9 Overview of the Project panel with, from top to bottom, (i) the project description module, (ii) the decompression module 
with the 1D isentropic model selected showing both the mixture table and part of the decompression grid entry fields, and (iii) the 

display module using the Figures display format to show the decompression path. 

3.4 Units and Preferences panel 
The Units and Preferences panel is located on the right-hand side of the Graphical User Interface (GUI). Figure 

10 shows an overview of the panel.  It follows a similar structure as that of the Project panel. It is composed 

of two sections: a section relevant to decompression modules and one relevant to fracture modules. 

Information about the preferences available for each module is provided in Chapter 5. 

 

3.5 Display panel 
The Display panel is located at the centre of the interface. It will display information under different formats 

depending on the status of the calculations and the display format selected by the user.  

 
Upon start-up of the application, the Display panel shows the logo of the application as shown in Figure 3. 

Accessing the logs or the GUI options from the View menu (section 3.2.2) will display the log panel and the 

GUI option panel as shown in Figure 6 and Figure 7 respectively. 

 
Other forms of displays are accessible from the display module located at the bottom of the Project panel. They 

relate to the display of results computed or loaded by EPDECOM. There are two formats available to display 
the results: figures and tables. The Figures module gives access to the Decompression path figure, the Two-Curve 

figure, the Charpy V-Notch (CVN) energy figure and the Mixture properties figure. The Tables module gives access 

to the Decompression table and the Fracture table. These two modules are discussed in sections 5.6 and 5.7 

respectively. 
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Figure 10 Units and Preferences panel showing (i) the preferences for the 1D decompression model, (ii) the components of GERG 

2008 EOS that are visible from the mixture composition table in the project panel and (iii) the preferences for the EPCRC Y/T 
model. 
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4 General use 
This chapter focuses on the general use of EPDECOM. The order of the chapter’s sections can be seen as 

the typical sequence a user would follow to complete a study, namely: 

1. Understand the context, 

2. Consider the applicability of the models for the design at hand, and their limitations, 

3. Set the preferences and units, 

4. Set or load the details of the project, 

5. Calculate the phase boundary of the mixture to better visualise if/when two-phase decompression 

can occur, within the range of operating conditions, 

6. Calculate the decompression curves within the range of operating conditions, 

7. Calculate the minimum required arrest capacity, 

8. Save the project setup, and;  

9. Export the data. 

 

Details on each of these steps are covered in each subsection below. For more information on the user 

interface, see chapter 3, and for details on the models, refer to chapter 5.  

 

Any information required to conduct a study is entered in the project panel (section 3.3). The set of 

information necessary will depend on the selected decompression and fracture models, as detailed in chapter 

5. Not all information is compulsory to conduct a study. 

 

4.1 Context 
Fracture is an important consideration in the design of steel pipelines. The conditions that cause a defect in 

a material to grow (rupture) and to stop growing (arrest) must be determined because steel pipelines are long, 

continuous structures, and therefore a crack can propagate for a long distance if it is not arrested.  

 

The material property of the pipe that defines how it will resist fracture is toughness. The tougher a pipe is, 

the larger the amount of energy required to create a crack is, and hence the greater is its tolerance to defects. 

A generalised method for predicting the fracture propagation toughness requirement was developed by the 

Battelle Institute, called the Battelle Two-Curve Method (BTCM). In the BTCM, two equations are 

developed – the relationship between decompression wave-speed and pressure, and the relationship between 

fracture velocity and hoop stress. 

 

As each of these equations applies to a mixture and any number of initial conditions, many numerical 

computations are required which are best provided using a dedicated software package. EPDECOM V2.0 

is an implementation of the NG18 equations used in the original BTCM. It uses modern equations of state, 

in particular GERG 2008, to predict the decompression wave speed, providing better predictions of the 

toughness requirement than other similar software packages. Several correction factors are available in the 

software as required. EPDECOM is intended for use in assessing designs involving the transport of rich gas, 

complex mixtures and/or CO2 mixtures. One application of this is in the control plan against running ductile 

fracture (RDF) in API5L pipes used in high pressure transmission pipeline applications. 

 

When the length of an initial crack exceeds a certain level, the crack starts to propagate. Gas rapidly escapes 

through the tip of the crack. During the early stages of the crack propagation, the internal gas pressure can 

be assumed to momentarily remain the same as the full opening necessary for non-steady outflow of the gas 

has not yet been established [1]. Decompression starts when the opening is full; the internal pressure and 

corresponding hoop stress drop. As gas flows towards the rupture, a decompression wavefront travels down 

the pipeline, causing a pressure gradient that varies from operating pressure far down the pipeline, to a 

fracture velocity dependent pressure at the section of the running crack tip [1]. The relationship between 

pressure and velocity of decompression is given by the decompression wave velocity characteristic of the 
mixture. In EPDECOM the decompression wave speed is calculated using either of the decompression modules 

(sections 5.2 and 5.3) and displayed on the Two-Curve figure (section 5.6.1.2).  

 

As a crack starts to propagate, the velocity of the propagation initially increases. Once the pressure upstream 

of the crack tip decreases, the hoop stress in the pipeline decreases. The decrease in stress leads to a decrease 

in fracture velocity. When the hoop stress reaches a certain value, the fracture propagation velocity drops to 

zero and the running fracture stops. Therefore, the criterion for a ductile fracture to arrest is that the 

decompression wave speed must travel faster than the speed of the crack, at all pressures from operating 

pressure down to the arrest pressure, so that the stress driving the crack reduces below the arrest stress. In 
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EPDECOM the fracture velocity curve is calculated using either one of the fracture modules (sections 5.4 and 

5.5) and displayed on the Two-Curve figure (5.6.1.2). 

 

In gas pipelines, the decompression process is “slow” due to the expansion of the mixture. Ductile cracks 

grow in the order of 100 to 300m/s. A ductile fracture would propagate indefinitely if the velocity of the 

fracture is greater than the velocity of the gas decompression wave. Schematically this situation arises if the 

fracture velocity curve admits a region that sits below the decompression curve, as shown by Curve 3 in 

Figure 11. If the fracture velocity is always lower than the decompression wave velocity then the fracture 

arrests, as shown by curve 1 in the figure.  

 

Toughness

Fracture 

curves

Curve 3
Curve 2

 

 
P

re
s
s
u
re

Velocity

Decompression 

curve

Curve 1

 
Figure 11 Schematic of possible interactions between the decompression curve and the fracture curve. Curve 1: Fracture arrest, curve 

2: limit of propagation, curve 3: fracture propagation. 

The condition of tangency between the two curves represents the limit between arrest and propagation of 

the fracture. This condition is illustrated by curve 2 in the figure. The fracture propagation toughness, taken 

as the Charpy V-Notch toughness, associated to the tangency condition is the minimum required toughness 

necessary to arrest the running fracture. The pressure at the origin of the limit fracture velocity curve, i.e. at 

Vf=0 in curve 2 of Figure 11, is referred to as the arrest pressure. The reader is referred to section 0 for a 

detailed theoretical background. 

 

In the Battelle Two-Curve Method, an iterative calculation is required to determine the tangency between 

the decompression wave velocity curve and the fracture velocity curve.  

 

4.2 Applicability and Limitations 
A classic BTCM study requires a model to describe the fracture velocity curve and a model to describe the 

decompression wave speed curve for the mixture. There are many models available in the literature. 

EPDECOM V2.0 currently provides two models for each curve. 

 

Of the two fracture models available, the primary model is the original fracture model developed at the 

Battelle Memorial Institute and referred to in this document as the NG18 model [4]. The second model is 

the Energy Pipelines CRC Y/T model (EPCRC Y/T) [5]. The latter is targeted towards grades of steel at 

and above X70 without using correction factors. It accounts for the influence of the yield to tensile ratio on 

the arrest capacity of the pipes. Refer to sections 5.4 and section 5.5 for the implementation details of each 

model and to the appendix for the theoretical background.  Both models define the arrest capacity of pipes 

based on their geometry, strength properties and toughness. Toughness is based on the measured full-size 

Charpy energy. 

 

In general, both fracture models are applicable to common lean and rich natural gas mixtures used in the 

transmission pipeline industry, provided that the decompression curve in the assessment depicts the actual 

decompression curve conservatively, for the range of operating pressures and temperatures of the pipeline. 
This is normally the case if the user selects the one-dimensional isentropic decompression model (section 5.2), 

as this model is supported by calls to the GERG 2008 equation of state (EOS) computing library. Expert 

assessment is nonetheless advised to judge the validity of the predicted decompression curve. 
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As an alternative to the aforementioned decompression model, users can supply their own set of 

decompression curves; calculated from third party applications or obtained from decompression tube 

experiments (section 5.3). EPDECOM V2.0 does not provide guarantees on the validity of the results based 

on user-supplied decompression curves. Expert assessment is highly recommended in this case. 

 

In general, users must exert expert knowledge to consider the suitability of the decompression model and 

the fracture model used in the BTCM. Design parameters must be weighed against the scope of the models, 

their calibration database and the applicability of the correction factors. Please refer to each model 

description provided in this manual as well as the relevant published literature. 

 

Despite historically being a slow-moving technology, RDF control does evolve regularly. Expert knowledge 

of recent developments, associated scientific publications and standards can be instrumental in judging of 

the suitability of a model for less common mixtures and pipe materials. In particular, whereas GERG 2008 

is suitable to predict the decompression curve of dense-phase CO2 mixtures1 from EPDECOM, the NG18 

and the EPCRC Y/T fracture models are not suitable to determine the required toughness for these 

mixtures. 
 

Other mixtures for which limited full-scale burst tests are available should be considered with caution and 

expert advice should be sought. An experimental program involving decompression tubes and full-scale tests 

may be required as an alternative to numerical predictions. 

 

4.3 Changing preferences and units 
EPDECOM provides a flexible approach to set the preferences of models and the units of input and output 
parameters through the Units and Preferences panel (section 3.4). The units of all numerical inputs and outputs 

can be changed at any time using this panel. Numerical input entry fields, figures and tables are 

automatically updated as preferences are changed. 

 

In particular, inputs can be typed in the entry fields of a project using a particular unit. The unit in the 

preference panel can be changed to convert the numerical entry automatically. Please note that rounding 

errors may occur between units.  

 

4.4 Setting or loading project details 
The description of the pipeline project is limited to the name of the pipeline and the name of the section. 

This information is not compulsory for computation, but it is useful to keep track of several studies. The 
information is provided through the Project module (section 5.1) and saved in setup files or exported data files. 

Setup files can be loaded from the File menu of the menu bar (section 3.2.1) to automatically populate models 

based on the setup file content. Calculations are not carried out automatically once a setup file has been 

loaded.  

 

4.5 Calculating the phase boundary 
The phase boundary can be calculated from the 1D isentropic model as discussed in section 5.2. This model 

requires information on the mixture composition. Mixtures can be saved and loaded individually from the 

interface. This can be useful to conduct studies on different pipeline designs.  

 

The 1D isentropic decompression model provides more information on the thermodynamics of mixtures 

than the decompression file option. The decompression file option allows external decompression curves to 

be imported but does not provide the benefit of the additional mixture information and adjustment. 

 

For mixtures with more than one component, users can calculate and visualise the two-phase boundary in 

the temperature-pressure plane. The feature is useful to observe how the decompression path can interact 

with the two-phase region, depending on the initial conditions. If calculated, the phase boundary is 

automatically included in the export data file (section 4.9). 

 

                                                           

 
1 The reader is referred to the report of the tripartite project conducted by APGA-EPRG-PRCI on the validity 

of the predictions of the GERG 2008 EOS for anthropogenic CO2 mixtures. See [10]. 
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4.6 Calculating the decompression curve 
Calculating decompression curves requires information on the decompression calculation step, the initial 

pressure range and initial temperature range. Users also provide the number of pressure and temperature 
points nP and nT within these ranges. EPDECOM calculates all the decompression curves, i.e. nP × nT cases 

and presents them in a temperature-pressure grid, discussed below in section 4.6.2.  

 

Decompression paths can be visualised in the temperature-pressure plane, along with the two-phase 

boundary if applicable, as detailed in section 5.6.1.1. Alternatively, they can be visualised in the velocity-

pressure plane from the Two-Curve figure (section 5.6.1.2) to inspect interactions with fracture velocity 

curves. Thermodynamic properties can also be visualised graphically by selecting a property for each axis 

(section 5.6.1.4). Calculated decompression data, encompassing the decompression curve data and the 

thermodynamics data, can be inspected from the decompression tables (section 5.7.1.1). All the 

decompression data are included in the export data file (section 4.9). 

 

Feedback is provided on success, warnings or failure to calculate decompression cases through the various 

figures and tables as well as in the export data file.  

 

4.6.1 Loading a decompression curve 
As an alternative to calculating decompression curves, users can import multiple curves by selecting several 

files from a file browser. The imported files must follow a particular format to allow EPDECOM to account 

for possible change of units between imported files and user selected units. 

 

There is no restriction on the decompression curves being from the same mixtures, but each imported curve 

must have a unique initial (temperature, pressure) point. EPDECOM imports the curves and sets them in a 

temperature-pressure grid, discussed below in section 4.6.2. 

 

Not all formats available to access data of calculated decompression curves are available for imported 

decompression curves. Decompression paths are not available as no thermodynamics data is supplied in the 

import file. Decompression curves can be visualised in the velocity-pressure plane from the Two-Curve 

figure (section 5.6.1.1) or inspected from the decompression tables (section 5.7.1.1). Imported 

decompression curves are included in the export data file (section 4.9). 

 

4.6.2 Accessing cases in the decompression calculation grid 
Irrespective of whether decompression data is set by the user as part of the 1D isentropic model (section 5.2) 

or by importing several decompression curves (section 5.3), EPDECOM presents the various decompression 

curves as a grid of a range of initial pressures and temperatures. This allows easy navigation of what can 

become a large number of cases.  

 
The calculation grid can be visualised as a matrix of nT temperature points column-wise by nP pressure points 

row-wise. The temperature increases from the first column to the last column of the grid. The pressure 

increases from the bottom row to the top row of the grid.  

 

A case identifying number, or case id, is given by the following equation: 

 

𝑖𝑑 = 𝑖𝑇 + (𝑖𝑝 − 1) × 𝑛𝑇      (1) 

 

Where:  

𝑖𝑇 = the index of the temperature point starting at 1, i.e. the column number starting from the left, 

𝑖𝑝 = the index of the pressure point starting at 1, i.e. the row number starting from the bottom,  

𝑛𝑇 = the number of temperature points in the grid.  

 
Case 1 is the cell at the bottom left of the matrix, case nT×nP is the cell at the top right. Figure 12 shows an 

example 10x5 calculation grid where the top right cell would be case 50, where 𝑖𝑇=10 and 𝑖𝑝=5. 

 

This notion of a decompression calculation grid is central to the interaction of the user with the data. The 

user interface allows the selection of a particular decompression case through a drop-down list, keyboard 

arrow keys or mouse selection. 
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Figure 12 Format of the calculation grid with temperature points given column-wise and pressure points given row-wise. 

The first method is from the drop-down list in the display module at the bottom of the Project panel. The drop-

down list enumerates the case ids. Selecting a particular case from the list will automatically set that case’s 

data in the figure or the table that is currently displayed. While this method is acceptable for a small grid, it 
becomes cumbersome over a larger one as the user needs to know the id of a case to access it. 

 

The second method is using the arrow keys of the keyboard. It is activated in two ways. Every time a 

decompression or a fracture calculation is completed, case selection by arrow keys will be automatically 
activated. It is deactivated whenever the user selects an item from the Project panel, the Units and Preferences 

panel or the Menu bar. To reactivate the selection mode, simply move the mouse pointer over the figure or 

table shown in the Display panel. 

 

The left and right arrow keys move the selected case to the left or right from the active case in the grid, i.e. 

the case moves at constant pressure while changing the temperature point. The down and up arrow keys 

move the selected case to the above or below case in the grid, i.e. the case moves at constant temperature 

while changing the pressure point. The change of cases wraps around the grid automatically, e.g. moving 

right from the last column of the grid selects the first column of the grid. 

 
Tables and figures provide feedback information on the currently selected case by displaying the case id and 

the initial temperature-pressure point at the top of the screen, in the units selected by the user. Figure 13 

provides an example of this for the Two-Curve figure. Information on how each type of figure or table 

provides feedback on the active case is provided in sections 5.6 and 5.7 respectively. 

 

 
Figure 13 Illustration of access to a case from the Two-Curve figure. Both decompression and fracture curves are displayed for case 34 
of a 10x5 calculation grid. The grid is displayed at the bottom right corner of the figure with a filled marker indicating the active case. 

Tool tips along the active column and active row inform of the initial temperature and pressure for the case.  

 

Grid temperature points 

Grid pressure points 
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Figure 14 Close up on a decompression path figure for which the case issued a warning. The grid is used as an indicator of the 

starting points for the decompression path in this figure. Part of the two-phase region, in green, is visible at the bottom. The 

decompression path enters the phase-boundary. The active marker is highlighted in orange, advising the user of a warning. The 
status message at the top of the window indicates that some points failed during the calculation and that some points observe an 

increase in speed of sound above the threshold rate of 10 m.s-1.bar 

The third method to access a case is restricted to interactions with figures. Figures have a display of the grid 
on their bottom right corner, except for the Decompression path figure which uses the grid to explicitly show 

the starting points of the decompression paths. A left-click from the mouse over the case’s marker in the grid 

will automatically display the data for this case in the figure.  

 

The active marker is filled. Inactive markers are empty. Grey markers indicate that the status of the 

calculations is OK. An orange marker signals a warning. A red marker indicates a problem. Selecting the 

coloured markers will provide further information on the warning or the error, see Figure 14 for an 

illustration of a case with a warning. 

 

4.7 Calculating the minimum required arrest capacity 
Once decompression curves have been calculated or imported, users can focus on calculating the minimum 

arrest capacity of the design for each decompression case. 

 

The required arrest capacity of a pipe depends on its geometry (diameter, wall thickness), its strength 

properties, toughness and other design factors such as backfill depth or type. Both the NG18 and the EPCRC 

Y/T models require the user to provide the geometry and strength properties of the pipes and information 

on either type or depth of backfill. EPDECOM calculates the minimum required arrest capacity by 

calculating the minimum required toughness of the pipe steel. This translates to the minimum required full-

size Charpy energy. It is the latter that is provided to the user. The Charpy energy is eventually provided 

with various correction factors depending on the fracture model selected. 

 

Once the fracture model is selected and the input information is provided, EPDECOM will calculate the 

required Charpy energy for all the decompression curves available. Calculation errors are reported to the 

user through the log panel (section 3.2.2), pop-up windows and messages within tables and figures. Users 

can interact with the fracture velocity cases using the same methods used with the decompression curves, 

namely, using a drop-down list, arrow keys from the keyboard or the mouse to navigate through the cases 

(section 4.6.2).  
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The fracture velocity data can be presented in several formats. The fracture velocity curve can be visualised 

in the Two-Curve figure along with the decompression curve (section 5.6.1.2) or from the fracture velocity 

table (section 5.7.1.2). Charpy full-size energy can be visualised from the Charpy graph as function of 

pressure at constant temperature or as function of temperature at constant pressure across the decompression 

calculation grid.  

 

4.8 Saving a project setup 
The setup of a study can be saved to file for later use from the project module (section 5.1) or from the File 

menu of the menu bar (section 3.2.1). All numerical input parameters and options are saved.  

 

Project inputs related to file names are saved as strings in the setup file. Moving the location of these input 

files will result in failure to load them automatically when loading a setup file (section 4.4). 

 
The setup file is a text file in ‘.eppj’ format. It can be edited manually in any text editor as long as the file 

format is retained. Please note that the format is subject to changes between versions of EPDECOM. As 

such, while manual editing is possible, it is not officially supported. 

 

4.9 Exporting data 
Setup data and results obtained from calculations can be exported to a Microsoft Excel spreadsheet from the 
project module (section 5.1) or from the File menu of the menu bar (section 3.2.1). 

 

The format of the export file is self-explanatory with a set of sheets relevant to different information sets. 

One sheet provides the setup of the study, e.g. the input parameters and selected models. Another sheet 

records data from the phase boundary if available. Individual sheets for each decompression case provide 

decompression data and fracture velocity data and the status of these calculations. All fracture curves are 

included in the export data file in the same sheets as their respective decompression curves.  

 

Charpy energies are summarised in a dedicated sheet. They are tabulated in the decompression calculation 

grid as function of initial temperature and initial pressure. A dedicated Charpy energy table is provided for 

each correction factor available in the model  

 

Calculation errors are also reported in the export file.
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5 Modules 
Computational modules are presented in this chapter. Many of the modules have an interface to the user on 
the Project panel (section 3.3) as well as an interface on the Units & Preferences panel (section 3.4). 

 
Entry fields used to provide inputs to modules change colour depending on their status and context. A ‘sandy 

yellow’ tone indicates that filling this entry is compulsory. A white entry field indicates either an optional field 

or a valid entry. Greyed out entries indicated a disabled field in the current context of the application. 

 

5.1 Project module 
The Project module provides basic functionalities to identify the pipeline and its section and to manage project 

setup files.  

 

5.1.1 Interface and usage 
The main interface to this module is located at the top of the Project panel as shown in Figure 15. 

 

 
Figure 15 Interface to the Project module from the Project panel. 

Both the pipeline name and section name entries accept alphanumeric characters including spaces. The two 

fields are optional and can be left empty. 

 
The third item of this interface is used to save the project setup to a project setup file. It is made of the save 

setup button and a text field. A file browser opens upon clicking the button, as shown in Figure 5(b), to save 

the project setup to a file or overwrite an existing project setup file. This functionality is also accessible from 

the File menu (section 3.2.1). The path to the selected setup file is automatically written in the text field on 

the right of the button when a file location is chosen. 

 
The last item is used to export the data of a project to a project data file as a Microsoft Excel spreadsheet. It is 

made of the save data button and a text field. A file browser opens upon clicking the button, similar to that 

shown in Figure 5(b), to save the project data to a file or overwrite an existing project data file. This 

functionality is also accessible from the File menu (section). The path to the selected data file is automatically 

written in the text field on the right of the button when a file location is chosen. 

 
The module provides access to two supplementary functionalities that are not presented in the Project panel. 

The items New project and Load project are accessible from the File menu in the menu bar (section 3.2.1).  

 

EPDECOM keeps track of the last directory used to load or save a file to limit browsing the file system tree. 

 

5.1.2 Preferences 
This module has no preferences. 

 

5.1.3 Limitations 
 The project setup file (*.eppj) is a json file. Although it can be modified manually from a text editor, 

this feature is not officially supported. 

 

 Information about a pipeline project is limited to the pipeline name and the section name. 
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5.2 1D isentropic decompression module 
The 1D isentropic module is one of the two decompression ‘models’ available in EPDECOM V2.0. It provides 

functionalities to select a gas mixture, calculate phase boundary, define a range of initial temperatures and 

pressures, and display the decompression curves for each initial condition.  

 

The 1D isentropic decompression module provides a standard implementation of the unidimensional 

isentropic and inviscid model used to calculate decompression wave speeds as in decompression codes such 

as GASDECOM [6] [7], DECOM [7] [8], and EPDECOM V1.0 [9]. An equation of state (EOS) is required 

to calculate the density, speed of sound and temperature along the isentropic decompression. EPDECOM 

V2.0 uses the GERG 2008 EOS library implemented by Ruhr Universität Bochum, Germany [3] on behalf 

of the Groupe Européen de Recherches Gazières (GERG). The user manual for the library is available from 
the Documentation directory of EPDECOM under the installation directory (section 2.3.3). GERG 2008 is 

valid for wide ranges of temperature, pressure, and composition and covers the gas phase, the liquid phase, 

the supercritical region, and vapour-liquid equilibrium states for natural gases and other mixtures. It has 

demonstrated very good predictive performance with lean and rich natural gas mixtures as well as 

anthropogenic CO2 mixtures [10]. It is able to represent the most accurate experimental binary and multi-

component data for gas phase and gas-like supercritical densities, speeds of sound, and enthalpy differences 

mostly to within their low experimental uncertainties.   

 

By default, EPDECOM calculates the decompression curve using the pressure-entropy tuple of state 
variables to call GERG’s flash point subroutine. This is referred to as the PS calculation mode. In most cases 

this mode is well suited, and particularly efficient to follow an isentropic path. In some situations, it is 
preferable to use the TP mode, as discussed in section 5.2.1.5 

 

5.2.1 Interface and usage 

 Equation of state 

This module is activated from the 1D Isentropic model drop-down list available from the Project panel, see 

Figure 16. 

 
Figure 16 Select the 1D Isentropic model from the drop-down list of the Project panel 

Once the model is selected, the interface to the module appears, see Figure 17. It is composed of two parts. 

The upper part offers the selection of the equation of state (EOS). V2.0 only allows GERG 2008 at this stage.  

 

  
Figure 17 The interface to the module is displayed below the decompression model drop-down list. (left) It is composed of a section 

relevant to the equation of state and tools to load, save and specify the composition of the mixture. (right) A section is also 
provided to set the details of the calculation grid and the decompression step. 
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 Mixture composition 

Below the EOS is the text entry for the mixture name. Any alphanumerical characters are permitted, 
including spaces. Two buttons, Load mixture and Save mixture, allow mixtures to be reused once they are 

saved to files. Clicking on either the Load mixture or Save mixture buttons opens a file browser to select or 

write, or overwrite a mixture file. Mixture files are written in .epmx format. Upon loading a mixture, the 

molar fractions of the components appear in the mixture table below the Load mixture button. 

 
The mixture table is used to define the molar fraction of the mixtures. It is made of two columns: Component 

and Molar fraction. The Component column lists the components the user sets as visible from the Units & 

Preferences panel (section 5.2.2). Reducing the number of visible components in the table eases interactions. 

 
To enter the molar fraction of a component, click the relevant row along the Molar fraction column. Positive 

or null entries are accepted, alphabetical or special characters are not. The total fraction of the mixture is 

updated in real time as the fractions are entered.  

 

Although the total fraction must be equal to 1.0, it is possible to fill the table to a total of 100.0 (or another 
preferred base) and then click the Normalise button, shown on the right of Figure 17. The table can be reset 

to zero by clicking on the Reset button located next to the Normalise button. 

  

Any change to the composition of a mixture will clear the memory of all fracture curves, decompression 

curves and phase boundary calculated in previous steps.   

 

 Calculating the phase boundary 

The Calculate phase boundary button is available for ‘mixtures’ of at least two components. When selected 

EPDECOM will call the EOS to obtain the phase boundary. The boundary will be displayed in the 

Decompression path figure (section 5.6). Some mixtures lead to failed phase boundary calculations from the 

EOS library. In these cases, an Error message will be displayed. Clicking OK will return the user to the main 

interface. It is recommended to adjust the mixture composition to one which has a calculable phase 

boundary; however, although not ideal, a phase boundary calculation error does not preclude subsequent 

calculations of decompression curves. 

 Setting the decompression calculation grid 

The second section of the 1D Isentropic module focuses on the definition of the decompression calculation 

grid. As shown on the right side of Figure 17, the user can fill the settings for the calculation grid in the area 
below the Phase boundary button. The units of all pressure and temperature entries can be changed from the 

Units and Preference panel (section 5.2.2).  

 

The first entry of the section is the decompression step. It is a strictly positive pressure fraction used to control 

the decompression calculations. It is the maximum pressure step allowed between two pressure points. The 

smaller the decompression step the more accurate the decompression curve. Small decompression steps can 

be useful to limit the unphysical slope of a decompression plateau inherent to the use of a non-zero 

decompression step. The decompression computing time increases linearly with the decompression step. 

The fracture velocity computing time increases exponentially with the decompression step2.  

 

Below the decompression step are six entries which are used to set the decompression calculation 

(temperature-pressure) grid. A minimum and maximum for both temperature and pressure, and the number 

of points within each range, can be defined. If a single point is used, then only the entry box for the minimum 

is accessible. Each point of the grid defines an initial condition which is used to calculate a decompression 

curve.  Refer to section 4.6.2 for details on the grid and how to interact with each case in the grid. 

EPDECOM will carry out consistency checks to validate that the minimum is less than the maximum and 

that the arrays are within the accepted range of the equation of state.  

 

Any change to the decompression step or definitions of the grid will clear the memory of all fracture curves 

and decompression curves. The phase boundary, if calculated for the mixture, will be retained. 

 

                                                           

 
2 The fracture curve is based on a non-linear pressure step to refine the number of points close to the arrest 

pressure. The maximum pressure step of the fracture curve is close to the pressure step of the decompression 

curve. 
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 TP mode – An alternative calculation routine 

A check box “Use TP calculation” is available immediately below the decompression settings. By default, 

EPDECOM calculates the decompression curve using the pressure-entropy tuple of state variables to call 
GERG’s flash point subroutine. This is referred to as the PS calculation mode. In most cases this mode is 

well suited, and particularly efficient to follow an isentropic path. However, it has some limitations. Some 

GERG 2008 subroutines (such as the calculation of the phase boundary) cannot be called within the two-

phase region for a ‘mixture’ made of a single component (i.e. a pure component, 100% molar fraction). 

Therefore, the TP mode is necessary to calculate decompression curves for ‘mixtures’ having only one 

component or when the default pressure-entropy (PS) mode leads to instabilities of the calculations in the 

equation of state. In TP mode, EPDECOM calculates the properties of the mixtures using the temperature-

pressure tuple of state variables i.e. (T, P). For more information on PS and TP modes, refer to the theory 

in the appendix. 

 

The TP mode can also be useful to calculate decompression curves of multi-component mixtures whenever 

GERG 2008 hits convergence issues. These are typically identified from the loss of points in the 

decompression curve, unphysical oscillations of thermodynamics properties or crashes of the GERG library. 
In such cases the TP mode can help overtaking these issues, albeit this is not guaranteed. 

 
Because of the internal optimisation of TP mode, it is significantly slower than the default PS mode. 

 
Using the TP mode is not the only possible approach to circumvent convergence or instabilities of the EOS 

library. Users can also move the initial conditions to pass around, but close to, a troublesome region of the 

decompression. Having two decompression curves surrounding the targeted, but failing, decompression 

curve can be sufficient to estimate the required toughness through interpolation for instance. Similar 

techniques can be applied by changing the composition of the mixture ever so slightly. 

 

 Calculating decompression 

The last interface to the module is the Calculate decompression button. Clicking it will run the decompression 

calculations. The computing time will vary depending on the size of the grid, the decompression step and 

the complexity/type of the mixture. The interface is locked during the calculation process. The progress bar 

of the interface will provide feedback on the progress status. Decompression cases with warnings or errors 

will issue an information window to inform the user. Calculations proceed once the information window 

has been closed. Warnings and errors are automatically recorded by the log system and accessible from the 

log panel (section 3.2.2). 

 

Once the decompression calculations are completed, EPDECOM will display the first case of the grid in the 

active display format or the Two-Curve figure by default. Decompression data can be accessed through figures 

(section 5.6)  and tables (section 5.7) using the case selection methods (section 4.6.2) as well as from the 

export data file (section 4.9). 

 

5.2.2 Preferences 
The preferences of the module are accessed by selecting the 1D Isentropic model from the Decompression model 

drop-down list of the Units & Preferences panel (section 3.4) as shown in Figure 18. 

  

 
Figure 18 Selection of the 1D isentropic model to access the preferences of the module. 

The user is presented with the preferences interface in the panel as shown in Figure 19. The pressure unit 
can be selected from {bar, Pa, kPa, MPa, psi, ksi}. The temperature unit can be selected from {K, C, F}. The 

velocity unit can be selected from {m/s, f/s}. Note that the velocity unit of the fracture model is also adjusted 

by changing the velocity unit of the decompression curve. All pressure (not stress), velocity or temperature 

variables in input or output data will be converted to the new unit across the interface. 
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If one or several entries are already filled when changing the unit then the entries will be converted to the 

new unit automatically. Note that round-off errors can occur, especially with pressure units that change 

numerals by several orders of magnitudes (e.g. between Pa and MPa). 

 

The module provides a drop-down list to select the equation of state for which the user wishes to modify the 

preferences. V2.0 only provides GERG 2008, no other option is available from the drop-down list. 

 
Below the unit and EOS selection is the visible components table. The table lists all the components available 

from the equation of state in the first column and a check box associated with each component in the second 
column. Checking a box makes a component visible in the mixture composition table of the module (section 

5.2.1.2) displayed in the Project panel (section 3.3). Components made visible have their molar fraction set to 

zero in the mixture composition table.  

 

  
 

 
Figure 19 Preferences interface of the 1D Isentropic module is accessible from the Units & Preferences panel. 

Any change to the visibility of components will clear the memory of all fracture curves, decompression 

curves and phase boundary calculated in previous steps. 

 

5.2.3 Limitations 
 Viscosity of the mixture is not accounted for in this decompression model. 

 

 There is no thermal exchange with the pipe wall. 

 

 The properties of the mixture from the equation of state are quasi-static properties. Dynamic effects 

such as delayed nucleation are not considered. 

 

 Some thermodynamics properties are not defined within the two-phase region. For instance, the 

speed of sound must be calculated using the method presented in the Appendix. 

 

 The properties of the mixture in the two-phase region assumes a homogeneous state3, in equilibrium 

between phases. The properties of each phase are not accounted for separately. 

 

 Mixture files (*.epmx) are written in json format. The files can be edited manually using a text editor. 

However, this feature is not officially supported. 

 

 Success of the decompression calculation depends upon the underlying performance of the equation 

of state, its stability and handling of errors. 

 

 The one-dimensional nature of the model restricts its use to account for the pressure field upstream 

of the crack tip, not downstream of the fracture where a supersonic flow takes place. 

 

5.3 Decompression file module 
The Decompression file module is the second of the two decompression ‘models’ available in EPDECOM V2.0. 

It provides functionalities to import one or several decompression curves saved in files under a specific 

format.  

                                                           

 
3 e.g. for a decompression path entering the two-phase region from the dew curve, the mixture is assumed 

to be akin to a mist in suspension in the gas phase.  
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5.3.1 Decompression files 
The format of a decompression file is illustrated in Figure 20. The file uses the comma separated value (csv) 

format, typically identified by the .csv extension. The file has only two columns. The first column is the 

decompression wave speed data, the second is the gauge pressure. There can be only one decompression 

curve per file. 

 
The first line is the header of each column. The first header is written as ‘W [unitW]’. Where: 

 unitW is any velocity unit accepted by EPDECOM: {m/s, ft/s}.  

 Units are case sensitive. 

 
The second header is written as ‘P [unitP] @ T=X[unitT]’. Where:  

 unitP is any pressure unit accepted by EPDECOM: {bar, Pa, kPa, MPa, psi, ksi}. 

 unitT is any temperature unit accepted by EPDECOM: {K, C, F}.  

 Units are case sensitive.  

 X is the numerical value for the initial temperature for which the decompression curve was measured 

or calculated. 
 

Subsequent lines in the file give the decompression wave speed and the gauge pressure from the initial 

pressure to an arbitrary minimum pressure or minimum decompression velocity. There is no restriction on 

the uniformity of the pressure steps between each pressure point. 

 

 
Figure 20 The format of a decompression file includes information provided in the headers, the data relevant to the decompression 

wave speed W and that of the gauge pressure P. 

 

5.3.2 Interface and usage 
The Decompression file module is activated from the Decompression model drop down list available from the 

Project panel, see Figure 21(a). 

 

 
(a) 

 
(b) 

Figure 21 (a) Select the Decompression file model from the drop-down list of the Project panel. (b) The interface to the module is a 

single button and a test field listing the decompression files selected by the user. 

 

Once the model is selected, the interface to the module is presented to the user, see Figure 21(b). It is 
composed of the Decompression files button and a text field. Clicking the button opens a file browser to let the 

user select one or several files from a source directory as shown in Figure 22. The list of selected files is 

automatically written in the text field on the right of the button. 

 
The loading process of a decompression file starts by reading the units of the file. The decompression wave 

speed array, the gauge pressure array and the initial temperature are converted to the units selected by the 

user under the Units and Preferences panel (section 3.4).  

 

If more than one file is being loaded, EPDECOM checks that each decompression curve is related to a 

unique initial (temperature, pressure) point. The initial condition is given by the temperature entry in the 

header and the first pressure point. A decompression curve is not loaded if a curve with the same initial point 
was previously loaded. EPDECOM will automatically update the Two-Curve figure to display the first 

available decompression curve. 
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Figure 22 A file browser opens for the user to select one or several files from a source directory. Here the user selected three files 

sample_decompression_1, 2 and 3. 

EPDECOM will construct a grid based on the array of unique temperatures and unique gauge pressures. 

Consequently, the grid may account for more cases than were loaded. For example, consider two 
decompression files with respective initial points (12.1, 15.0) and (11.0, 6.3) in (C, MPa) units. Thus, the 

unique temperature and pressure arrays are (11.0, 12.1) and (6.3, 15.0) respectively. The grid is composed 

of two temperature points and two pressure points for a total of 4 cases. When visualising the data in the 
Two-Curve figure, EPDECOM will show the markers for case 2 (12.1, 6.3) and for case 3 (11.0, 15.0) in red 

because these cases were not provided as part of the decompression files import process. See section 4.6.2 for 

more details about the representation of the calculation grid in EPDECOM. 

 

5.3.3 Preferences 
The Decompression file module preferences are accessed from the Decompression model drop down list available 

from the Units & Preferences panel, see Figure 23a). 

 

 
(a) 

 
(b) 

Figure 23 (a) Selection of the decompression file model from the Units & Preferences panel to access its preferences. (b) Preferences 
interface of the module once the model has been selected. 

The preferences of the module are limited to selection of the units for pressure, temperature and velocity, 
see Figure 23(b). The pressure unit can be selected from {bar, Pa, kPa, MPa, psi, ksi}. The temperature unit 

can be selected from {K, C, F}. The velocity unit can be selected from {m/s, f/s}. Note that the velocity unit 

of the fracture model is also adjusted by changing the velocity unit of the decompression curve. All pressure 

(not stress), velocity or temperature variables in input or output data will be converted to the new unit across 

the interface. 

 

5.3.4 Limitations 
 The decompression files must be in the same source directory. Importing files from different 

directories is not supported.  

 

 It is permitted to have an incomplete decompression curve provided in a file, with the last pressure 

point at a non-zero velocity. However, the tangent condition calculated from the fracture models 
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may fail if the fracture velocity is constrained, by design, to velocities below that of the last pressure 

point of the decompression curve. 

 

5.4 NG18 fracture module 
The original Battelle Memorial Institute fracture model – referred to here as the NG18 model – uses small-

scale lab tested material properties to characterise ductile fracture propagation behaviour in the full-scale 

pipe. It is based on two assumptions [4]: 

a) The fracture propagation velocity is proportional to the plastic wave velocity. The ductile fracture 

and the plastic zone ahead of the fracture are assumed to be equivalent to some large value of plastic 

deformation that can be described by small-scale material properties. The concept also considers 

that this high level of plastic strain can only propagate as fast as the plastic wave [2]. 

b) The fracture propagation velocity is affected by the difference between the arrest pressure and the 

pressure at the crack tip. 

 

The predictive performance of the NG18 equations were compared with an extensive full-scale test database 

[4] [11]. The equations showed a deviation in the predictions beginning at a full-size Charpy energy of about 

95 J. This observation indicated a loss of accuracy of the model towards non-conservative predictions of the 

Charpy energy; that is, a design based on the predicted Charpy energy would be progressively more likely 

to fail at stopping RDF as the Charpy energy requirement increased. This led to the development of 

correction factors, applied to the predicted Charpy energy for toughness greater than 95J. Three correction 

factors have been implemented in EPDECOM to correct the NG18 model: one developed by Leis [11], one 
developed by Wilkowski et al., called the Wilkowski 1977 equation [12], and another developed by 

Wilkowski called the Wilkowski 2000 equation [13] [14]. Further details about the model theory and these 

correction equations can be found in the Appendix. 

 

5.4.1 Interface and usage 
The NG18 fracture module is activated from the fracture model drop-down list of the Project panel (section 3.3) as 

shown in Figure 24a. The interface is displayed in the Project panel as shown in Figure 24b. It includes 

selection of the backfill mode, and text entries for the wall thickness, elastic modulus and yield strength. All 

these quantities are compulsory to run the model. The tensile strength is optional. If the entry field is left 

empty then the flow stress σ̅ is defined as σ̅ = σY +  10 ksi. Otherwise the flow stress is defined as the average 

of the yield and tensile strength: σ̅ =  (σY + σT)/2. 

 

 

 

 

 

 

 

 

 
(a) 

 
(b) 

Figure 24 (a) Select the NG18 model from the drop-down list of the Project panel to activate the module. (b) Once activated the 
NG18 module displays its interface in the Project panel.  

 

Any change to the input parameters of the module deletes the existing fracture velocity curve and predicted 

Charpy energy from the memory. 

 
Minimum required toughness is calculated by clicking the Calculate toughness button. The calculations are 

attempted for all the decompression curves available in memory. Possible calculation errors are notified 

through message windows and recorded in the logs. 
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5.4.2 Preferences 
The preferences of the NG18 fracture module are activated from the fracture model drop-down list of the Units & 

Preferences panel (section 3.4) as shown in Figure 25a. The interface to the preferences is displayed in the 

panel as shown in Figure 25b. 

 

 

 

 

 

 

 

 
(a) 

 
(b) 

Figure 25 (a) Select the NG18 model from the drop-down list of the Units & Preferences panel to access the module’s preferences. 
(b) Preferences interface of the 1D Isentropic module is accessible from the Unites & Preferences panel.  

The preferences of the module are limited to selection of the units for the diameter, wall thickness, elastic 

modulus, strengths (yield strength, tensile strength) and fracture energy. 

 
The unit for the diameter and the wall thickness is selected in {mm, m, inch}. The unit for the elastic modulus 

is selected in {MPa, GPa, ksi, psi}. Strength units are selected in {MPa, kPa, Pa, ksi, psi}. Fracture energy 

units are selected in {J, ft.lbf}. Note that the velocity unit of the fracture model is adjusted above in the 

decompression preferences module as it also sets the velocity unit of the decompression curve. 

 

5.4.3 Limitations 
The original form of the NG18 model has numerous limitations: 

 It requires corrections for predicted Charpy energies above ~95J. Applicable correction factors for 

a particular design are subject to export knowledge and consideration. 

 

 The corrections required have been shown to depend on the grade of the steel and possibly its 

vintage. 

 

 The model has been calibrated against full-scale tests using mostly lean natural gas, air and nitrogen. 

The extent of the validity with other mixtures is subject to expert knowledge and consideration 

 

 In particular, the model is not applicable to the prediction of Charpy energy for pipelines 

transporting mixtures predominantly composed of dense-phase CO2 . 

 

 Charpy energy measurements have their own issues [11] with some features of the fracture process 

(e.g. separations, sometime referred to as splits [15] [16]) affecting the results and introducing much 

scatter in the data. 

 

5.5 EPCRC Y/T fracture module 
The NG18 fracture velocity equation is based on the assumption that the fracture propagation velocity is the 

same as the plastic wave speed and that each is proportional to the slope of the stress-strain curve at the 

characteristic strain. The characteristic strain was determined from fracture mechanics and it was assumed 

that the flow stress corresponds to the characteristic strain in the stress-strain curve. However, there is no 

evidence to prove this. It is known that the slope of the stress-strain curve varies widely from the yield point 

to the ultimate tensile stress. Therefore, improper use of the stress/strain pair may result in inaccurate 

prediction of the fracture velocity, in turn leading to an inaccurate prediction of the arrest toughness. 

 

The EPCRC Y/T model retains the assumption that the fracture propagation velocity is the same as the 

plastic wave speed and they are proportional to the slope of the stress-strain curve at the characteristic strain.  

However, the characteristic strain is re-defined. The basic assumption of the Battelle fracture velocity model 

is that the fracture propagates along with the upstream plastic zone at a characteristic strain. Therefore, the 

energy used in the fracture velocity model should only be the energy required to reach the characteristic 

strain, not the total energy generating the fracture. Compared to the NG18 model, this model not only 
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considers the effects of the strength and toughness of the material, but also considers the effect of (uniaxial) 

ductility. 

 

A full-scale fracture propagation test database was established to calibrate the model. The calibration was 

driven by optimising the predictions to achieve the following two objectives: 

1) All the predicted Charpy arrest energy values of the propagation pipes are higher than their actual 

values. This ensures that the model is conservative against the calibration data. 

2) The root mean square of the difference between the predicted Charpy arrest energy and the actual 

Charpy energy of all the arrest points is minimised. 

 

5.5.1 Interface and usage 
The EPCRC Y/T fracture module is activated from the fracture model drop-down list of the Project panel (section 

3.3) as shown in Figure 26a. The interface is displayed in the Project panel as shown in Figure 26b. It 

includes text entries for the pipe outer diameter, wall thickness, elastic modulus, yield and tensile strengths 

and backfill depth. All these quantities are compulsory to run the model. Any change to the input parameters 

of the module deletes existing fracture velocity curve and predicted Charpy energy from the memory. 

 

 

 

 

 

 

 

 

 
(a) 

 
(b) 

Figure 26 (a) Select the EPCRC Y/T model from the drop-down list of the Project panel to activate the module. (b) Once 

activated the EPCRC Y/T module displays its interface.  

 

Minimum required toughness is calculated by clicking the Calculate toughness button. The calculations are 

attempted for all the decompression curves available in memory. Possible calculation errors are notified 

through message windows and recorded in the logs. 

 

5.5.2 Preferences 
The preferences of the EPCRC Y/T fracture module are activated from the fracture model drop-down list of the 

Units & Preferences panel (section 3.4) as shown in Figure 27a. The interface to the preferences is displayed in 

the panel as shown in Figure 27b. 

 

 

 

 

 

 

 

 

 
(a) 

 
(b) 

Figure 27 (a) Select the EPCRC Y/T model from the drop-down list of the Units & Preferences panel to access the module’s 

preferences. (b) The preferences of the module.  

The preferences of the module are limited to selection of the units for the diameter, wall thickness, elastic 

modulus, strengths (yield strength, tensile strength), backfill depth and fracture energy. 
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The unit for the diameter and the wall thickness is selected in {mm, m, inch}. The unit for the elastic modulus 

is selected in {MPa, GPa, ksi, psi}. Strength units are selected in {MPa, kPa, Pa, ksi, psi}. The backfill depth 

units are selected in {m, mm, inch, foot}. Fracture energy units are selected in {J, ft.lbf}. Note that the 

velocity unit of the fracture model is adjusted above in the decompression preferences module as it also sets 

the velocity unit of the decompression curve. 

 

5.5.3 Limitations 

 The model is only suitable for buried pipes, not for unburied pipes.  The backfill depth used in the 

parameter calibration ranges from 0.5 m to 1.5 m. 

 

 Round bar tensile specimens should be used to define the yield and tensile strengths with the yield 

strength taken as Rt05. 

 

 The calibration database focuses on X70 to X100 pipes in natural gas and air. The application of 

the model is therefore targeted towards higher grades.  

 

 The extent of the validity with other mixtures is subject to expert knowledge and consideration. 

 

 In particular, the model is not applicable to the prediction of Charpy energy for pipelines 

transporting mixtures predominantly composed of dense-phase CO2 [17] [18]. 

 

 The calibration database is small compared to that of the NG18 model, this enforced the 

requirement for a conservative calibration process. As a result, the model can be particularly 

conservative, especially with large Y/T ratios. 

 

 Charpy energy measurements have their own issues [11] with some features of the fracture process 

(e.g. separations, sometime referred to as splits [15] [16]) affecting the results and introducing much 

scatter in the data. Well known limitations of Charpy energy in the NG18 model are carried over 

in the EPCRC Y/T model. 

 

 The flow stress is always defined as σ̅ = σY +  10 ksi. 

 

5.6 Figure display module 
There are four types of figures available in EPDECOM. All axes displayed in the figures have units that can 
be changed on-the-fly from the Units & Preferences panel (section 3.4). They all provide a display of the 

calculation grid from which computed decompression and fracture cases can be accessed (section 4.6.2).  

 

Unless the user clicks a point of the calculation grid, it is possible to display an arbitrary point in the figure 

with a display of the coordinate using a left click of the mouse. A right click would make the tooltip 

disappear. 

 

5.6.1 Interface and usage 
The Figure display module is activated from the Display format drop-down list accessed from the Project panel 

(section 3.3) as shown in Figure 28a. Once activated the module will display a drop down list from which 

the different figures can be selected as shown in Figure 28b. 

 
Each figure, namely the Decompression path figure, the Two-Curve figure, The Charpy V-Notch (CVN) energy figure 

and the Mixture properties figure, have different options. Some do not have any. The various options displayed 

for each figure within the panel are shown in Figure 29. 

 

The Decompression path figure and the Two-Curve figure allow some of the curves to be hidden if the user wishes 

to focus on a particular curve. The Mixture properties figure allows the user to select which properties to 

plot against one another. 
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(a) 

 
(b) 

Figure 28 (a) Select the Figure item of the Display format drop-down list from the Project panel to activate the module. (b) Select 
the figure of your choice from the Graph drop-down list. Four types of figures are available: Decompression path, Two-Curve, 

CVN energy and Mixture properties.  

 

 
(a) 

 

 
(b) 

 

 
(c) 

 
(d) 

Figure 29 Summary of the interfaces of each available figure with their eventual options. (a) Decompression path & phase 
boundary figure, (b) Two-Curve figure, (c) Charpy energy figure and (d) Mixture properties figure.  

 The Decompression path figure 

A typical Decompression path figure is shown in Figure 30. The figure displays the phase boundary of the 

mixture (if it has been calculated successfully) and the decompression path for the active case.  

 

In the example, a calculation grid of 5 temperature points by 5 pressure points is shown. Cases can be 

selected using the keyboard arrow keys or the mouse within the figure as discussed in section 4.6.2.  

 

Here case 1 has been selected. The figure has an information region at the top centre which displays initial 

pressure and temperature and the status of the calculation for the active case. 

 

 The Two-Curve figure 

A typical Two-Curve figure is shown in Figure 31. The figure can display the decompression curve (grey) and 

the fracture velocity (red). This presents the user with a rapid assessment of the quality, or lack of, of the 

decompression calculations and the tangent condition between the two curves. 

 

In the figure, a calculation grid of 5 temperature points by 5 pressure points is shown. Cases can be selected 

using the keyboard arrow keys or the mouse within the figure as discussed in section 4.6.2. An orange circle 

is visible within the grid, indicative that a warning was issued for that case. The user can click the circle to 

show the relevant figure and inspect the warning.  

 

Here case 2 has been selected. Tool tips are shown along the calculation grid in the bottom right corner to 

inform of the initial conditions for the active case (-12.5 °C and 10 MPa in the figure).  

 

The figure also displays information at the top centre. The grey information region refers to the 

decompression model. The decompression calculations were successful in this case. The red information 

region refers to the fracture model. The calculations were successful and the Charpy energy from the NG18 

model and its three correction factors are displayed. 
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Figure 30 The Decompression path & phase boundary figure showing the boundary in green and the decompression path for case 1 

along with the decompression grid initial conditions. 

 
Figure 31 The Two-Curve figure showing the decompression curve in grey and the fracture velocity of the NG18 model in red for case 
2 of the calculation grid. Both the decompression curve and the fracture curve returned an OK status. The NG18 model provides the 

Charpy energy along with several correction factors. 
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 The Charpy energy figure 

 

 
Figure 32 The Charpy energy figure set to show the fracture energy as function of the initial temperature of the calculation grid at a 

constant pressure of 15 MPa. 

A typical Charpy energy figure is shown in Figure 32. The figure displays the uncorrected Charpy energy as 

function of the temperature points or the pressure points of the calculation grid at constant pressure or 

temperature respectively. This presents the user with a rapid assessment of the evolution of the required 

energy as a function of a particular variable of the initial conditions. 

 

In the figure a calculation grid of 5 temperature points by 5 pressure points is shown. The upper row of the 

grid is selected. The grid indicates that the figure displays the Charpy energy as function of temperature at a 

constant pressure of 15 MPa.  

 

Moving the up/down arrow keys would display the evolution of the energy as function of temperature at a 

higher/lower pressure. A left-click from the mouse over any point in a different row would display the curve 

for that row. 

 

If the user uses the left/right arrow keys, the figure will automatically switch to a visualisation of the energy 

as function of pressure at constant temperature. Switching from constant pressure to constant temperature 

and vice versa can also be done by using a right click on the mouse over one of the grid points. 

 

 The Mixture properties figure 

A typical Mixture properties figure is shown in Figure 33. The figure can display any of the mixture properties 

(Pressure (P), temperature (T), density (D), speed of sound (C), entropy (S) and enthalpy (H)) against 

another, along the decompression path. The user can select the two properties from the option panel as 

shown in Figure 34.  

 

Units of the figure for pressure, temperature and velocity can be changed from the active decompression 

module preferences (e.g. section 5.2.2). Density, entropy and enthalpy units cannot be changed from the 

interface as they use the units provided by the equation of state. 

 

5.6.2 Preferences 
All units of the figures can be changed from the Units & Preferences panel (section 3.4) through the preferences 

of the decompression and fracture modules depending on the type of variables being displayed.  

 

Pressure, temperature and velocity units are changed from the preferences of the decompression modules. 

Units for Charpy energy can be changed from the preferences of the fracture modules. 
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Figure 33 The Mixture properties figure set to show the density as function of temperature. 

 
Figure 34 The Mixture properties figure provides lists to select the properties to display along the abscissa and ordinate axes. 

5.6.3 Limitations 
 There are no Zoom & Pan functionalities within the figures, 

 

 Figures cannot be saved as images, 

 

 Units for density, entropy and enthalpy cannot be changed. 

 

 Only the Charpy energy without correction is displayed in the Charpy energy figure.  

 

5.7 Table display module 
There are two types of tables available in EPDECOM. All columns of the tables, with the exception of 
density, entropy and enthalpy, have units that can be changed on-the-fly from the Units & Preferences panel 

(section 3.4). 

 

5.7.1 Interface and usage 
The Tables display module is activated from the Display format drop-down list accessed from the Project panel 

(section 3.3) as shown in Figure 35a. Once activated the module will display a Table drop down list from 

which the different tables can be selected as shown in Figure 35b. 

 

 
(a) 

 
(b) 

Figure 35 (a) Select the Table item of the Display format drop-down list from the Project panel to activate the module. (b) The 
module provides two types of tables: the Decompression data table and the Fracture data table.  
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 The Decompression table 

A typical Decompression table is shown in Figure 36. The table displays the thermodynamic variables along 

the decompression path as well as the error code, if any, returned by the equation of state. The headers 

inform of the properties in each column and the current units. 

 

Information is displayed above the table’s headers to inform of the active case, its initial conditions and the 

status of the calculations. The case to visualise can be changed by using arrow keys or the case drop-down list 

available from the Project panel (section 4.6.2).  

 

 
Figure 36 View of the Decompression table for case 22. Initial conditions are summarised above the headers of the table along with 

the status of the decompression. 

 The Fracture table 

A typical Fracture table is shown in Figure 37. The table displays the gauge pressure and the fracture velocity 

of the fracture velocity curve. The headers inform of the variable in each column and the current units.  

 

Information is displayed above the table’s headers to inform of the active case, its initial conditions and the 
status of the calculations. The case to visualise can be changed by using arrow keys or the case drop-down list 

available from the Project panel (section 4.6.2).  

 

 
Figure 37 View of the Fracture table for case 22. Initial conditions are summarised above the headers of the table along with the 

status of the calculation. 

5.7.2 Preferences 
All units of the tables can be changed from the Units & Preferences panel (section 3.4) through the preferences 

of the decompression and fracture modules depending on the type of variables being displayed.  

 

Pressure, velocity and temperature units are changed from the preferences of the decompression modules.  

 

5.7.3 Limitations 
 Units for density, entropy and enthalpy cannot be changed in the decompression table. 

 

 There is no Charpy energy table. 
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Appendix: Background theories 
 

Forewords: The Australian code of practice for the control of fracture of steel pipeline provides a more 

complete discussion on the state of the art. The reader is encouraged to consult it for further information 

[19].  

 

A Decompression model theory 

A.1 Basis of 1D isentropic decompression models 
The 1D isentropic decompression module provides a standard implementation of the unidimensional 

isentropic and inviscid model used to calculate decompression wave speeds as traditionally implemented in 

decompression codes such as GASDECOM [6] [7], DECOM [7] [8], and EPDECOM V1.0 [9]. 

 

In this model, the decompression wave speed W of a mixture is calculated by: 

 

𝑊 = 𝐶 − 𝑢                                                                       (2) 

 

Where: 
C is the speed of sound behind the decompression wave, and  

u is the mean outflow velocity behind the decompression wave.  

 
Increments in pressure along the isentropic decompression process are used to calculate C and u. The outflow 

velocity u at any given pressure is the sum of the incremental Δu determined from 

 

𝑢 = ∑ ∆𝑢|𝑠

𝑃=𝑃0

                                                                       (3) 

where 

∆𝑢|𝑠 = −
Δ𝑃

𝜌|𝑠 . 𝐶|𝑠

                                                                    (4) 

 

 is the mass density of the mixture 

|𝑠 indicates calculations carried out at constant entropy,  

Δ𝑃 is the pressure step (Δ𝑃 < 0).  

 
The calculations are carried out from the initial absolute pressure 𝑃0 to the absolute choke pressure 𝑃𝑐 

identified when the decompression wave speed 𝑊 equals zero. In general, the decompression process leads 

to a decrease of the mixture’s temperature, decrease of the speed of sound, increase of the outflow velocity 

and a decrease of the decompression wave speed.  

 
An equation of state (EOS) is required to calculate the density, speed of sound and temperature along the 

isentropic decompression. For instance, the Benedict-Webb-Rubin-Starling (BWRS) EOS [20] is used in 

GASDECOM. EPDECOM V1.0 adopted the GERG 2008 EOS which demonstrated very good predictive 

performance with lean and rich natural gas mixtures as well as anthropogenic CO2 mixtures [10]. 

 

By default, EPDECOM calculates the decompression curve using the pressure-entropy tuple of state 
variables to call GERG’s flash point subroutine. This is referred to as the PS calculation mode. In most cases 

this mode is well suited, and particularly efficient to follow an isentropic path. In some situations, it is 
preferable to use the TP mode, as discussed in section 5.2.1.5. 
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A.2 The GERG 2008 Equation of state 
EPDECOM V2.0 uses the GERG 2008 library implemented by Ruhr Universität Bochum, Germany [3]. 
The user manual for the library is available from the Documentation directory of EPDECOM under the 

installation directory (section 2.3.3). 

 

GERG 2004 is valid for wide ranges of temperature, pressure, and composition and covers the gas phase, 

the liquid phase, the supercritical region, and vapour-liquid equilibrium states for natural gases and other 

mixtures consisting of 18 components: methane, nitrogen, carbon dioxide, ethane, propane, n-butane, 

isobutane, n-pentane, isopentane, n-hexane, n-heptane, n-octane, hydrogen, oxygen, carbon monoxide, 

water, helium, and argon. GERG 2008, the extended version of GERG-2004, considers three additional 

components n-nonane, n-decane, and hydrogen sulphide, resulting in a total of 21 components [21]. 

 

GERG 2008 is able to represent the most accurate experimental binary and multi-component data for gas 

phase and gas-like supercritical densities, speeds of sound, and enthalpy differences mostly to within their 

low experimental uncertainties.   

 

GERG 2004 and GERG 2008 are based on pure substance equations of state for each of the considered 

mixture components and correlation equations for binary mixtures consisting of these components. GERG 

equations of states are expressed in terms of the Helmholtz free energy as a function of temperature and 

density. The reduced Helmholtz free energy (α) is expressed in GERG EOSs by 

    (5) 

where the function αo represents the properties of the ideal-gas mixture at a given mixture density ρ, 

temperature T, and molar composition x̅ according to 

     (6) 

and the residual part αr of the reduced Helmholtz free energy of the mixture is given by 

   (7) 

where is the mixture reduced density and  is the mixture inverse reduced temperature given by: 

     (8) 

The dimensionless form of the Helmholtz free energy in Eqn. 6 in the ideal-gas state of component i is given 

by 

 (9) 

where ρc,i and Tc,i are the critical parameters of the pure component i. The residual part of the reduced 

Helmholtz free energy of component i is given by 

  (10) 

The function  αij
r (δ, τ) in Eqn. (7) is given by 
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 (11) 

The values of the coefficients nij,k and the exponents dij,k, tij,k, ij,k, ij,k, ij,k, and ij,k were determined by non-

linear multi-property regression analysis. A database of more than 100,000 experimental data points for the 

thermodynamic properties of binary mixtures, natural gases and other multi-component mixtures was used 

to develop the structure, coefficients and parameters of the correlation equations for binary mixtures, and to 

evaluate the behaviour of the equation of state.   

 

The pure substance equations of state for each of the considered mixture components used in the mixture 

model in GERG 2004/GERG 2008 are typically simpler than the equations of state for the pure 

components, e.g. the equation for carbon dioxide in GERG 2004/GERG 2008 has 22 terms, compared to 

the 42 terms in the Span and Wagner EOS [22].  

GERG 2008 is able to represent the most accurate experimental binary and multi-component data for gas 

phase and gas-like supercritical densities, speeds of sound, and enthalpy differences mostly to within their 

low experimental uncertainties [21].   

a) The normal range of validity of GERG 2008 covers temperatures of 90 K ≤ T ≤ 450 K and pressures 

of P ≤ 35 MPa. The uncertainty of GERG 2008 in gas phase density and speed of sound is less than 

0.1% in the temperature range from 250 K~270 K to 450 K at pressures up to 35 MPa. This 

uncertainty is valid for various types of natural gases as well as for many binary and other mixtures 

consisting of the 21 natural gas components covered by GERG 2008.   

b) In the liquid phase, the uncertainty of GERG 2008 in density amounts to less than 0.1 to 0.5% for 

many binary and multi-component mixtures. The estimated uncertainty in liquid phase (isobaric) 

enthalpy differences is less than 0.5 to 1%.   

c) The Vapour-Liquid Equilibrium (VLE) is described with reasonable accuracy.  Accurate vapour 

pressure data for binary and ternary mixtures consisting of the main natural gas components are 

reproduced by GERG2008 to within their experimental uncertainty, approximately 1 to 3%. 

The GERG 2008 library can conduct flashpoint calculations based on a range of state variable tuples such 
as Temperature-Pressure (T,P) and pressure-entropy (P,S). The library can calculate the boundary of the two-

phase region for multi-component mixtures. 
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A.3 TP mode – An alternative calculation routine 
By default, EPDECOM calculates the decompression curve using the pressure-entropy tuple of state 
variables to call GERG’s flash point subroutine. This is referred to as the PS calculation mode. In most cases 

this mode is well suited, and particularly efficient to follow an isentropic path. However, it has some 

limitations. 

 

Some GERG 2008 subroutines cannot be called within the two-phase region for a ‘mixture’ made of a single 

component (i.e. a pure component, 100% molar fraction). For instance, the calculation of the phase 

boundary is not possible from the routine. Routines based on the pressure-entropy tuple of state variables 

are not callable. 

 
Whenever a user calculates the decompression curve of a pure component, the TP calculation mode must 

be used. In this mode EPDECOM calculates the properties of the mixtures using the temperature-pressure 

tuple of state variables i.e. (T, P). 

 

Starting from the initial temperature and pressure condition, EPDECOM obtains the initial entropy and 

other thermodynamics properties from GERG 2008. All subsequent calculations at lower pressure points 

will be invoked using the temperature at the previous pressure point and the pressure at the current point. 

An internal EPDECOM convergence routine optimises the temperature until the entropy at the new pressure 

point is equal to the initial entropy within precision. Once the Temperature has been optimised EPDECOM 

obtains all other thermodynamics properties using GERG’s TP flashpoint subroutine. 

 

It is possible to inspect if the decompression conserves the entropy within reasonable bounds from the 

decompression tables (section 5.7) or the export data file (section 4.9). 

 
Second, the TP mode can be useful to calculate decompression curves of multi-component mixtures 

whenever GERG 2008 hits convergence issues. These are typically identified from the loss of points in the 

decompression curve, unphysical oscillations of thermodynamics properties or crashes of the GERG library. 
In such cases the TP mode can help overtaking these issues, albeit this is not guaranteed. 

 
Using the TP mode is not the only possible approach to circumvent convergence or instabilities of the EOS 

library. Users can also move the initial conditions to pass around, but close to, a troublesome region of the 

decompression. Having two decompression curves surrounding the targeted, but failing, decompression 

curve can be sufficient to estimate the required toughness through interpolation for instance. Similar 

techniques can be applied by changing ever so slightly the composition of the mixture. 

 
Because of the internal optimisation carried out on in TP mode, the method is significantly slower than the 

default PS mode. 
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A.4 Speed of sound of a mixture in the two-phase region 
Some thermodynamics properties of a mixture are undefined within the two-phase region if the two phases 

are not considered individually. This is the case for the speed of sound. This is evidently a problem when it 

comes to the 1D isentropic model whenever the decompression path has a section in that region. 

 

The traditional approach is to assume that the speed of sound of this “homogeneous” multi-phase fluid can 

be approximated by the fundamental equation of the speed of sound as shown in Eqn. 12. 

 

𝐶 = √
𝜕𝑃

𝜕𝜌
|

𝑠
≈ √

Δ𝑃

Δ𝜌
|

𝑠
     (12) 

Where  

C is the speed of sound,  

𝑃 the absolute pressure and  

𝜌 the density.  

The subscript ‘𝑠’ indicates that the partial derivative is taken along an isentropic path. 

 

The equation can be approximated numerically within the two-phase region by calculating the change in 

density between two pressure points, close to each other, along the isentropic path of the decompression. 

 

For calculations using the TP mode (section 5.2.1.5), the calculation of the density at these pressure points 

involves the optimisation routine carried on the temperature. 
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B Fracture module theory 

B.1  NG18 fracture model 
The Battelle Memorial Institute developed a fracture propagation velocity model in the 1970s [2]. It aimed 

to use small-scale lab tested properties of the material to characterise ductile fracture propagation behaviour 

in the full-scale pipe. It was based on two assumptions [4]: 

a) The fracture propagation velocity is proportional to the plastic wave velocity. The ductile fracture 

and the plastic zone ahead of the fracture are assumed to be equivalent to some large value of plastic 

deformation that can be described by small-scale material properties. The concept also considers 

that this high level of plastic strain can only propagate as fast as the plastic wave [2]. 

b) The fracture propagation velocity is affected by the difference between the arrest pressure and the 

pressure at the crack tip. 

 

The derivation procedure of the Battelle fracture propagation model is briefly described in the following. 

The plastic wave velocity has been found to be proportional to the square root of the slope of the stress-strain 

relationship [4]. Based on assumption a) one obtains: 

Vf ∝ √
dσ

dε
                                                                       (13) 

where Vf is the fracture propagation velocity,  is the stress and  is the strain. The stress-strain relationship 

from the yield stress to the ultimate tensile stress can be generally expressed by a power law, namely: 

σ = Aεn                                                                       (14) 

where n is the strain hardening component, which can be determined by a tensile test. Eqn. 14 gives the 

slope of the stress-strain relationship as: 

dσ

dε
∝ nεn−1 ∝ n

σ

ε
                                                          (15) 

Substitution of Eqn. 15 into Eqn. 13 yields: 

Vf ∝ √
σ

ε
                                                                      (16) 

The material’s resistance to fracture R extracted from the tensile test results correspond to the area below the 

stress-strain curve. It is expressed by 

𝑅 = σ̅ε                                                                          (17) 

where σ̅ is the flow stress, σ̅ = σY +  10 ksi, and σY is the yield stress. Therefore, Eqn. 16 can be rewritten 

as: 

Vf ∝
σ̅

√𝑅
                                                                        (18) 

Alternatively, the material’s resistance to fracture R can also be expressed as the specific Charpy plateau 

energy: 

𝑅 =
CV

Ac

                                                                          (19) 

where CV is the Charpy plateau energy (upper shelf energy) and Ac is the fracture area of the Charpy 

specimen. 
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When the length of the initial crack exceeds a certain level, the crack starts to propagate. During the early 

stages of the crack propagation, the crack propagation velocity increases, but the internal gas pressure can 

be assumed to momentarily remain the same as the full opening necessary for non-steady outflow of the gas 

has not yet been established [1]. The decompression starts when the opening is full, so that the internal 

pressure and corresponding hoop stress drops and the fracture propagation velocity decreases. When the 

hoop stress drops to a certain value, the fracture propagation velocity becomes zero, and the fracture is 

arrested. This hoop stress value is termed the ductile fracture arrest hoop stress or ductile fracture arrest 

stress σa and the corresponding internal pressure is called the ductile fracture arrest pressure Pa. 

 

The ductile fracture arrest pressure provides the lower pressure boundary where the fracture velocity is near 

zero. At the arrest pressure the fracture behaves like a static event. Therefore, the pressure for the static 

fracture initiation can be used to determine the arrest pressure of the fracture propagation. Eqn. 20 has been 

used to predict the ductile fracture arrest pressure Pa. It is referred here as the NG18 arrest pressure equation. 

Pa =
σat

r
=

2σ̅t

πMTr
arccos (e

−(
πBRE
8cσ̅2 )

)                                       (20) 

where c is half of the crack length when the crack is arrested, t is the pipe wall thickness, r is the pipe radius, 

MT is the Folias bulging factor and B is a unit conversion factor.  

 

Two unknowns MT and c appear in Eqn. 20. MT can be calculated in terms of c using Eqn. 21, so that c 

remains the only unknown parameter in Eqn. 20. Figure 38 shows MTσh/σ̅ plotted against (CvBE)/(σ̅2√rt)  

from full-scale test data. 

MT = (1 + 1.255
c2

rt
− 0.0135

c4

(rt)2
)

0.5

                                  (21) 

In Figure 38 the solid line, representing 𝑐/√𝑟𝑡 = 3, best separates the propagation data and arrest data. 

𝑐/√𝑟𝑡 = 3 corresponds to MT = 3.33. Therefore, the arrest pressure equation can be rewritten as 

𝑃𝑎 =
2𝜎𝑡

3.33𝜋𝑟
𝑎𝑟𝑐𝑐𝑜𝑠 (𝑒

−(
𝜋𝐵𝑅𝐸

24√𝑟𝑡𝜎̅2)
)                                          (22) 

Figure 39 plots the pressure ratio 𝑃/𝑃𝑎 against the normalized velocity 𝑉𝑓/(𝜎/√𝐶𝑉/𝐴𝑐 derived from full-

scale tests [4]. Two sets of data are shown in Figure 39. One set (open squares) corresponds to backfilled 

pipes with approximately 30 inches of soil or sand cover. The other data set (open circles) corresponds to 

pipes without backfill. 

 

Based on data in Figure 39, Eqn. 23 was developed to describe the relationship between the pressure at the 

crack tip and the fracture velocity: 

𝑉𝑓 ∝ (
𝑃

𝑃𝑎

− 1)
𝛼

                                                          (23) 

where P is the fluid pressure at the crack tip and Pa is the arrest pressure. 

 

Combining Eqn. 18 and Eqn. 23 gives the basic form of the Battelle fracture velocity equation, referred here 

as the NG18 fracture velocity equation, as follows: 

𝑉𝑓 = 𝐶
𝜎

√𝑅
(

𝑃

𝑃𝑎

− 1)
𝛼

                                                         (24) 

There are two unknowns in Eqn. 24: C and . Curve-fitting of full-scale burst test data shown in Figure 39 

gives =1/6 and C = 0.47 for soil backfill and C = 0.648 for no backfill. 
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Figure 38 Ductile propagation and arrest at decompressed stress levels [6]. 

 
Figure 39 Relationship between the pressure at the crack tip and the fracture velocity [4]. 

In the Battelle Two-Curve Method, an iterative calculation is required to determine the tangency between 

the decompression wave velocity curve and the fracture velocity curve. This numerical approach was tedious 

before the advance in computing power. In order to simplify the calculation, the following equation, termed 

the PRC-BMI simplified equation, was developed by regressing the arrest toughness calculated by the BTCM 

for a specific set of operating conditions [1]: 

𝐶𝑉 = 3.57 × 10−5𝜎ℎ
2(𝑟𝑡)

1
3                                                 (25) 

where CV is the full-size Charpy energy. 
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Figure 40 Validation of the PRC-BMI simplified equation. 

The predictive performance of the NG18 equations were compared with an extensive full-scale test database 

[4] [11]. The database included data for 258 full-scale fracture propagation experiments. These data 

represented 120 arrest (47 percent of the total) and 138 propagation (53 percent) data points. The PRC-BMI 

simplified equation shows a deviation in the predictions as shown in Figure 40, beginning at a full-size 

Charpy energy of about 95 J. 

This observation indicated a loss of accuracy of the model towards non-conservative predictions of the 

Charpy energy; i.e. a design based on the predicted Charpy energy would be progressively more likely to fail 

at stopping a running ductile fracture as the Charpy energy requirement increased. This led to the 

development of correction factors applied to the predicted Charpy energy.  

The following sections present three correction factors implemented in EPDECOM to correct the NG18 

model. 

 

B.1.1  Leis correction model 

Leis developed an equation to correct the arrest toughness for toughness predicted by the BTCM or PRC-

BMI simplified equation greater than 95 J [11].  

𝐶𝑉𝑁𝐴𝑟𝑟𝑒𝑠𝑡 = 𝐶𝑉𝑁𝐵𝑀𝐼                 𝐶𝑉𝑁𝐵𝑀𝐼 < 95 𝐽                               (26a) 

𝐶𝑉𝑁𝐴𝑟𝑟𝑒𝑠𝑡 = 𝐶𝑉𝑁𝐵𝑀𝐼 + 0.002 × 𝐶𝑉𝑁𝐵𝑀𝐼
2.04 − 21.18                𝐶𝑉𝑁𝐵𝑀𝐼 ≥ 95 𝐽          (26b) 

where CVNArrest is the corrected full-size Charpy arrest energy. CVNBMI is the full-size Charpy arrest energy 

calculated with the BTCM or PRC-BMI simplified equation,  

 

B.1.2 Wilkowski correction models 

Wilkowski et al. [12] developed an equation, called the Wilkowski 1977 equation, to determine the corrected 

Charpy minimum arrest toughness for high toughness steels as follow. 

(E/A)Corrected−Charpy
W1977 =

(
3(E/A)BTCM + 1800

175
)

1
0.385

− 300

3
      (ft − lb/in2)       (27) 

where ((E/A)BTCM is the specific arrest toughness calculated by the BTCM. 
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In 2000 Wilkowski developed another correction model, called the Wilkowski 2000 equation, which is 

expressed as [14]: 

(𝐸/𝐴)𝐶𝑜𝑟𝑟𝑒𝑐𝑡𝑒𝑑−𝐶ℎ𝑎𝑟𝑝𝑦
𝑊2000 =

(
3(𝐸/𝐴)𝐵𝑇𝐶𝑀 + 1800

175
)

1
0.385

1.3
− 300

3
      (ft − lb/in2)       (28) 
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B.2  EPCRC Y/T Decompression file module theory 
The NG18 fracture velocity equation is based on the assumption that the fracture propagation velocity is the 

same as the plastic wave speed and that each is proportional to the slope of the stress-strain curve at the 

characteristic strain.  The characteristic strain was determined from fracture mechanics and it was assumed 

that the flow stress corresponds to the characteristic strain in the stress-strain curve. However, there is no 

evidence to prove that the flow stress and the characteristic strain calculated as part of the model are a pair 

in the stress-strain curve.  It is known that the slope of the stress-strain curve varies widely from the yield 

point to the ultimate tensile stress.  Therefore, improper use of the stress/strain pair may result in inaccurate 

prediction of the fracture velocity, in turn leading to an inaccurate prediction of the arrest toughness. 

 

Based on the basic assumption of the Battelle fracture velocity model, the fracture propagates along with the 

upstream plastic zone at a characteristic strain. Therefore, the energy used in the fracture velocity model 

should only be the energy required to reach the characteristic strain, not the total energy generating the 

fracture. 

 

The EPCRC Y/T model retains the assumption used to construct the NG18 fracture velocity equation. The 

fracture propagation velocity is the same as the plastic wave speed and they are proportional to the slope of 

the stress-strain curve at the characteristic strain.  However, the characteristic strain is re-defined. 

 

Leis proposed that fracture propagation in a gas pipeline is a collapse-controlled failure process [1] [23].  It 

has been experimentally observed that the through-wall (plastic) collapse (TWC) zone, which is evident 

from the axial through-wall thinning at the front of the fracture, continues to deepen and lengthen as the 

pressure increases to the limit pressure. Therefore, Leis pointed out that the pipe ruptures once this TWC 

zone reaches its critical length and depth, and thereafter propagates in the wake of the plastic wave that is 

triggered by rupture of the pipe. Failure through the net ligament via unstable shear gives rise to its axial 

propagation along the pipe. Failure thus depends on plastic collapse, and the flow properties of the steel that 

control its resistance to TW shear failure. 

 

The basic principle of the BTCM is to use material properties based on small-scale tests to predict the fracture 

behaviour of the full-scale pipe. It is necessary to determine the characteristic strain from the most commonly 

used small-scale mechanical test: the tensile test.  In the tensile test plastic instability is usually believed to 

occur at the ultimate tensile stress corresponding to uniform elongation εu. According to Leis’ theory, the 

characteristic strain used to calculate the fracture propagation velocity should correspond to the uniform 

elongation. That is Eqn. 13 should read: 

Vf = √
1

ρ

dσ

dε
|

ε=εu

                                                           (29) 

The Hollomon equation is used to describe the true stress-true strain behaviour during the tensile test, as 

shown in Eqn. 30: 

σ = Aεn                                                                  (30) 

where  is the true stress, ε is the true strain, A is the stiffness parameter and n is the strain hardening 

exponent. The material deforms uniformly until the occurrence of plastic instability in the tensile test.  In 

the regime of uniform deformation, true stress and true strain can be expressed in terms of the engineering 

stress σ∗ and the engineering strain ε∗ as: 

σ = σ∗(1 + ε∗)                                                            (31) 

ε = ln(1 + ε∗)                                                            (32) 

Therefore, Eqn. 30 can be rewritten as 

σ∗ = A
(ln(1 + ε∗))n

(1 + ε∗)
                                                    (33) 
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Plastic instability, which is evident as necking in the tensile test, generally occurs when the engineering stress 

reaches its maximum value.  At this point, the slope of the engineering stress-strain curve is zero: 

dσ∗

dε∗
|

ε∗=εu
∗

= 0                                                          (34) 

which gives 

εu
∗ = en − 1                                                             (35) 

where e is the base of the natural logarithm. The slope of the true stress-strain curve at ε = εu (or ε∗ = εu
∗ ) 

can be calculated by 

dσ

dε
|

ε=εu

= n
σu

εu

= n
σu

∗ (1 + εu
∗ )

ln (1 + εu
∗ )

                                        (36) 

where σu
∗  is the engineering ultimate tensile stress. The specific energy (Eu

∗ ) required to generate plastic 

instability in the tensile test can be determined by the area of the engineering stress-strain curve before 

necking (ε∗ ≤ εu
∗ ): 

Eu
∗ = ∫ σ∗dε∗

εu
∗

0

                                                        (37) 

Substitution of Eqn. 33 into Eqn. 37 gives 

Eu
∗ =

1

n + 1
σu

∗ (1 + εu
∗ ) ln (1 + εu

∗ )                                          (38) 

or 

ln (1 + εu
∗ ) =

(n + 1)Eu
∗

σu
∗ (1 + εu

∗ ) 
                                                   (39) 

Substitution of Eqn. 39 into Eqn. 36 yields 

dσ

dε
|

ε=εu

=
n

n + 1

(σu
∗ )2

Eu
∗

(1 + εu
∗ )2                                        (40) 

Here, σu
∗  can be expressed by 

σu
∗ =

σY
∗

Y/T
                                                                  (41) 

where σY
∗  is the engineering yield stress. Eu

∗  represents the plastic instability specific energy in the tensile test.  

However, this parameter is not usually measured. The Charpy absorbed energy (Cv) is the widely used 

toughness parameter in the pipeline industry.  Cv represents the total energy consumed in the Charpy impact 

test.   

 

In the EPCRC Y/T model the following relationship is assumed to link Eu
∗  to the specific Charpy energy 

R=Cv/Ac.  

Eu
∗ = (

εu
∗

εt
∗ )

m

R                                                             (42) 

where εt
∗ is the total elongation (total engineering strain to failure) and m is an unknown constant. 

Substitution of Eqns. 35 and 40-42 into Eqn. 29 gives: 

𝑉𝑓 ∝ 𝛽
𝜎𝑌

∗

√𝑅
                                                                      (43) 

𝛽 = √
𝑛

𝑛 + 1

𝑒𝑛

𝑌/𝑇
(

𝜀𝑢
∗

𝜀𝑡
∗)

−𝑚/2

                                                 (44) 
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The EPCRC Y/T model adopts the form of the NG18 arrest pressure equation (Eqn. 22) and NG18 fracture 

velocity equation (Eqn. 23) to link the pressure at the crack, the arrest pressure and the fracture velocity. In 

order to consider the effect of the backfill depth, the fracture propagation velocity is assumed to be 

proportional to the backfill depth (H) for the buried pipe:  

𝑉𝑓 ∝ (
𝐻0

𝐻
)

𝑘

                                                                         (45) 

where H0 is the reference backfill depth, it is set to 1 m in the model.  k is an unknown constant.  Thus, the 

new fracture velocity model is expressed as: 

𝑉𝑓 = 𝐶𝛽 (
𝐻0

𝐻
)

𝑘 𝜎𝑌
∗

√𝑅
(

𝑃

𝑃𝑎

− 1)
1/6

                                             (46) 

where C is an unknown constant. There are three calibration constants in the model: C, m and k. The strain 

hardening exponent n, the yield-to-tensile ratio Y/T and the ratio of uniform elongation to total elongation 

𝜀𝑢
∗ /𝜀𝑡

∗ are supplementary material properties. These three parameters are measures of the ductility of the 

material and are inter-related.  Compared to the NG18 model, this model not only considers the effects of 

the strength and toughness of the material, but also considers the effect of (uniaxial) ductility. 

 

A full-scale fracture propagation test database was established to calibrate the model.  The primary database 

includes data for 227 pipes from 32 full-scale tests published since 1980.  Out of this primary database, data 

for 95 pipes was carefully selected to calibrate the model. The selected data satisfied the following conditions: 

 transverse round bar yield stress and ultimate tensile stress were available in the database; 

 the selected pipes were buried in the full-scale test; 

 Initiation pipes and pipes located after the arrest pipes were excluded. 

 

As shown in Eqns. 44 and 46, the model requires the strain hardening exponent n and the ratio of the uniform 

elongation to the total elongation (𝜀𝑢
∗ /𝜀𝑡

∗).  These values are rarely available from published full scale test 

results. Fortunately, it was observed that the yield-to-tensile ratio Y/T is closely related to strain hardening 

exponent n and 𝜀𝑢
∗ /𝜀𝑡

∗ [24] [25]. Liessem et al. derived an analytical relationship between Y/T and n as 

follows [24]: 

1

𝑌/𝑇
= (1 + 𝜀𝑌

∗) (
𝑛

𝑒𝜀𝑌
∗)

𝑛

                                                                          (47) 

where 𝜀𝑌
∗  is the engineering strain at the yield strength. The yield strength available from most full-scale tests 

is Rt0.5, it is measured at a total strain of 0.5%. The strain 𝜀𝑌
∗  is therefore defined as 0.5% in the model. 

 

It is not convenient to use Eqn. 47 to explicitly calculate n from Y/T.  Instead, an explicit equation was 

developed, as shown in Eqn. 48, as an alternative to Eqn. 47.  

𝑛 = 0.1507(𝑙𝑛(2 − 𝑌/𝑇))
0.4607

+ 0.5745(𝑙𝑛(2 − 𝑌/𝑇))
1.6099

                                     (48)  

Ji et al. [26] reported the Y/T ratios and the 𝜀𝑢
∗ /𝜀𝑡

∗ ratios for a number of X70 and X80 pipes based on 

measurements from round bar tensile tests. The measured Y/T ratios and 𝜀𝑢
∗ /𝜀𝑡

∗ ratios in the transverse 

direction as reported by Ji et al are shown in Figure 41by solid circle symbols.  𝜀𝑢
∗ /𝜀𝑡

∗ decreases slightly with 

the Y/T ratio for relatively lower Y/T values. When the Y/T ratio exceeds approximately 0.85, 𝜀𝑢
∗ /𝜀𝑡

∗ 

decreases significantly as the Y/T ratio increases.  

 

The experimental data was best-fitted using Eqn. 49, the equation is shown in blue in Figure 41. Eqn. 49 

represents the trend of the experimental data adequately. 

𝜀𝑢
∗

𝜀𝑡
∗ = 0.429 × 𝑡𝑎𝑛ℎ(11.98(1 − 𝑌/𝑇))                                     (49) 
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Figure 41 Comparison of experimental data of Ref. [26] and predictions by Eqn. 49 

Calibration of the three parameters of the model (C, m, k) was conducted through a minimisation problem. 

The input dataset for calibration encompassed information on the gas composition, initial pressure and 

temperature, yield strength, Y/T ratio, pipe diameter and wall thickness, backfill depth, strain hardening 

exponent and 𝜀𝑢
∗ /𝜀𝑡

∗ for each of the selected full-scale tested pipe. All but the strain hardening exponent and 

𝜀𝑢
∗ /𝜀𝑡

∗ were available from the database. The strain hardening exponent and 𝜀𝑢
∗ /𝜀𝑡

∗ were calculated from Eqn. 

48 and Eqn. 49. 

 

The calibration was driven by optimising the predictions to achieve the following two objectives: 

3) All the predicted Charpy arrest energy values of the propagation pipes must be higher than their 

actual values. This ensures that the model is conservative against the calibration data. 

4) The root mean square of the difference between the predicted Charpy arrest energy and the actual 

Charpy energy of all the arrest points needs to be minimised. 

 

The optimisation results in C = 0.5842, m = 2.3711 and k = 0.5201, when using SI units (mm, MPa, J). The 

calibrated model is summarised here for convenience using the set of SI units (mm, MPa, J). 

 

𝑌/𝑇 =
𝜎𝑌

∗

𝜎𝑢
∗                                                                                                              

𝜎̅ = 𝜎𝑌
∗  

1 + 𝑌/𝑇

2 𝑌/𝑇
                                                                                                  

𝑃𝑎 =
2. 𝜎̅. 𝑡

3.33. 𝜋. 𝑟
𝑎𝑟𝑐𝑐𝑜𝑠 (𝑒

−
1000.𝜋.𝑅.𝐸

24.√𝑟𝑡.𝜎̅2 )                                                              

𝑛 = 0.1507. [𝑙𝑛(2 − 𝑌/𝑇)]0.4607 + 0.5745. [𝑙𝑛(2 − 𝑌/𝑇)]1.6099   (50) 

𝜀𝑢
∗

𝜀𝑡
∗ = 0.429 × 𝑡𝑎𝑛ℎ(11.98(1 − 𝑌/𝑇))                                                           

𝛽 = √
𝑛

𝑛 + 1
 

𝑒𝑛

𝑌/𝑇
 (

𝜀𝑢
∗

𝜀𝑡
∗)

−𝑚/2

                                                                             

𝑉𝑓 = 𝐶𝛽 (
𝐻0

𝐻
)

𝑘 𝜎𝑌
∗

√𝑅
(

𝑃

𝑃𝑎
− 1)

1/6

                                                                        

 

EPCRC Y/T model 
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It should be noted that: 

1) The model is only suitable for buried pipes, not for unburied pipes.  The backfill depth used in the 

parameter calibration ranges from 0.5 m to 1.5 m. 

2) The flow stress is always defined as σ̅ = σY +  10 ksi. 

3) The yield stress and ultimate tensile stress are measured by the round bar tensile test. 

 

The actual Charpy energies are plotted against the minimum required Charpy energies predicted by the 

model in Figure 42.  The 1:1 line is also marked in the figure. The hollow symbols represent ‘propagation’ 

pipes, while the solid symbols account for the ‘arrest’ pipes.  The square, star and triangle symbols denote 

the X70/75, X80 and X100 grade pipes, respectively.  All the ‘propagation’ points are located below the 1:1 

line.  This means that no correction factor is needed.  
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Figure 42 Actual Charpy energy against arrest toughness predicted by the new fracture velocity model 


